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This User’s Manual provides complete explanations of the features and functions of the printer. To
maximize the life of your printer, it’s a good idea to familiarize yourself fully with all of its functions.
All statements, technical information, and recommendations in this manual and in any guides or
related documents are believed reliable,. Print Planet is a service mark of Canon Computer Systems,
Inc. Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. Use this
button when you wish to enlarge the screen you are viewing. Select this button in the tool bar, and
then click within the screen of the User’s Manual. Click the desired item to jump to the topic. How to
Use This Manual Use this button when you wish to. Turning off the printer Choosing a location
Power supply. Do not remove the power cord from the power outlet until the printer has been turned
off by pressing the POWER button. Be sure to unplug the power cord from the power outlet after the
POWER light goes off. Keep the power outlet for the printer free of all obstacles so you can unplug
the power cord at any time.Power supply The socketoutlet shall be installed near the equipment and
shall be easily accessible. Always grasp the plug when you unplug the power cord. The correct
power supply voltage and frequency is Do not attempt to plug the power cord into the power outlet
or unplug the power cord when your hands are wet. Call the Canon Customer Care Center. Getting
Help From Canon Safety Precautions. The printer contains moving parts that could cause injury. If
you mistakenly turn on the printer while cleaning it, you could touch moving internal printer
components and suffer injury. Do not attempt to disassemble or modify the printer.This could cause
the ink to leak out and stain your clothing or the surroundings. Do not touch the metal contacts on a
BJ cartridge after printing. The metal parts may be very hot and could cause

burns.https://80ada.com/uploads/dv6000-repair-manual.xml
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Paper Output Tray Holds printed sheets after they are ejected from the printer. Paper Guide Ensures
that sheets from the paper stack in the auto sheet feeder feed straight into the printer. Power
Connector Provides a connection point for connecting the power cord to the AC power outlet. Printer
Cable Connector Parallel Interface Provides a connection point for connecting a parallel interface
cable to the printer. Standby status or print job in progress. Printer error. Remove the cause of the
error, then press RESUME to continue printing. Service error. Contact the Canon Customer Care
Center. Getting Help From Canon Parts and Functions of the Printer. Refer to any instructions
provided with special media for details about handling and printing.It is ideal for printing photos,
illustrations, and artwork. The paper is specially coated and printable on both sides. Do not use
transparencies designed for laser printers or photocopiers. Media type Plain Paper Artist Canvas.
Paper Thickness Lever Adjusts the gap between the print head and the surface of the paper you are
printing on. Media type Position Plain Paper Artist Canvas. Printing area dark gold Canon
recommends that you print within this area Printable area light gold The area where it is possible to
print. However, Letter, Legal. Printable Area width 203.2 mm 289.0 mm 141.2 mm 202.0 mm 175.2
mm 249.0 mm 32.0 mm 26.0 mm 3.4 mm 3.4 mm. Do not use the BC34e Photo B] Cartridge. Make
sure that the printer is turned on and the paper thickness lever is set to the Down position. Raise the
paper rest. Printing on Special Media Types Paper rest Paper thickness lever. Note You can load one
sheet of Artist Canvas in the auto sheet feeder. Specify the media type High Resolution Paper, and
the BJ cartridge installed in the printer. Using the Macintosh Printer Driver Start the print job.
Remove each printed sheet as it is ejected from the printer. Raise the paper rest. Paper rest Paper
thickness lever Paper Handling.http://weldingplaza.com/files/dv6000-manual.xml
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Specify the media type Back Print Film, and the BJ cartridge installed in the printer. Remove each
printed sheet of Back Print Film as it is ejected from the printer. Lower the paper rest. Paper rest
Paper thickness lever Paper Handling. Paper Handling. Windows In the Windows driver, you select
Banner Printing on the Page Layout tab. Printing on Banner Paper Macintosh When using a
Macintosh, select Banner Printing before creating a document using an application program.
Printing on Banner Paper Printing on Special Media Types Paper Handling. Raise the paper rest.
Paper rest Paper thickness lever Paper Handling. Normally you can set the paper size with the
application program. However, if the setting on the Page Layout tab does not match the setting in
the application program, or if your application program does not provide a size selection for Glossy
Photo Cards, specify the setting here. Using the Macintosh Printer Driver Start the print job.
Remove each printed card as it is ejected from the printer. Do not touch the printed side until the
ink is completely dry. About two minutes are required for drying. Raise the paper rest. Paper rest
Paper thickness lever Paper Handling. Note To avoid touching the print surface, always handle the
sheets by the edges. Select Glossy Photo Paper in the Media Type box. Also make sure that the BJ
Cartridge setting matches the B] cartridge installed in the printer. Raise the paper rest. Paper rest
Paper thickness lever Paper Handling. Select High Resolution Paper in the Media Type box. Also
make sure that the B] Cartridge setting matches the BJ cartridge installed in the printer. Change the
settings if necessary. Do not use the BC34e Photo B] Cartridge. Make sure the printer is turned on
and the paper thickness lever is set to the Up position. Align the right edge with the right side of the
auto sheet feeder and insert the sheet into the auto sheet feeder. Select High Gloss Photo Film in the
Media Type box.

The BJ Cartridge setting is automatically set to Color. Change the settings if necessary. Raise the
paper rest.Unclean or scratched print surfaces can adversely affect print quality.Select High
Resolution Paper in the Media Type box. Make sure the printer is turned on and the paper thickness
lever is set to the Down position. Printing on Special Media Types Paper rest Paper thickness lever.
Place both sheets on a hard surface to align the bottom edge and sides.Specify the media type
Glossy Photo Paper, and the BJ cartridge Color. Remove the printed Magnet Sheet as it is ejected
from the printer. Do not touch the printed side until the ink is completely dry. Raise the paper rest.
Printing on Special Media Types Paper rest Paper thickness lever. Windows Open the Printer
Properties dialog box, then select the most appropriate icon in the Choose Print Mode box under the



Main tab. Specify the media type Transparency, and the BJ cartridge installed in the printer. Remove
each printed transparency as it is ejected from the printer. Do not touch the printed side until the
ink is completely dry. Do not use the BC34e Photo B] Cartridge. Printing on Special Media Types
Paper rest Paper thickness lever. Print side up Windows Open the Printer Properties dialog box,
then select the most appropriate. Specify the media type TShirt Transfer, and the BJ cartridge Color.
Remove the printed TShirt Transfer as it is ejected from the printer. Transfer the image to the Tshirt
as soon as possible. Note You can load up to ten envelopes in the sheet feeder. Specify the media
type Envelope, and the BJ cartridge installed in the printer.When SuperPhoto is selected, the B]
Cartridge setting automatically changes to Photo so you can use the different types of inks provided
by the BC34e Photo B] Cartridge. Use the Photo Optimizer to compensate unsatisfactory color
balance and over or underexposure before printing. Windows Open the Printer Properties dialog
box, then click the Main tab.
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Click the Advanced button. The Photo Optimizer feature works on the image that is edited using the
edit menu such as Cut and Rotate in a graphics application program. Disabled Enabled Paper
Handling. To use the printer with your computer, you must install the printer driver. For instructions
on installing the printer driver, refer to the Quick Start Guide.Highlight the Canon S400 icon and
then select “Printing Preferences” from the File menu.Set the paper size you use from within the
application program before printing. Make sure that Canon S400 is selected in the Printer box. If
another printer name is displayed, click the downarrow and then select Canon S400 from the
pulldown list. The Printer Properties dialog box opens.Point to Settings, then click Printers. When
the Printers window is displayed, click the Canon S400 icon.Or, rightclick and select Properties from
the popup menu. The Properties dialog box opens. Note When you open the Printer Properties dialog
box from the Start menu, some other tabs such as General and Details are added by the Windows
operating system. The settings on the Quality, Special Effects, and Color tabs are the properties of


https://www.becompta.be/emploi/bosch-shu5312uc-manual

the print mode. Customizing the Print Settings in the Printer Driver— Creating an original print
mode Setting the Page Size Set the page size you use from within the application program before
printing. Click the downarrow in the Page Size box, then select the appropriate page size from the
pulldown list.Click the downarrow in the Page Size box, then select Custom Size from the pulldown
list. The Custom Paper Size dialog box is displayed.Finding information on a particular topic When
you click the “” button on the upper right corner of the Printer Properties dialog box, the shape of
the mouse pointer changes to “. When the contents of the Canon BJ Printer Driver Help are
displayed, select the desired item to learn more about that item.
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Make sure that the information on Direction, Feed, and Paper Thickness Lever in the illustrated
guideline is correct. Click the OK button. When you select a paper size in the Printer Paper Size box
which is different from the paper size originally set in the Page Size box, the enlargement or
reduction ratio is calculated automatically and is displayed in the Scaling box. You can save the total
amount of paper used for long documents. This feature is also useful when you wish to view an
image spread or print your document as a book cover. You can specify the detailed layout setting in
the Page Layout Printing dialog box.Pasting the pages after printing makes it possible to create a
largesized document such as an artistic poster. Setting the image divisions Open the Printer
Properties dialog box and click the Page Layout tab. You can specify a detailed image division
setting in the Poster Printing dialog box.For details on how to load banner paper in the printer, refer
to the Paper Handling section. Banner Paper Setting banner printing Open the Printer Properties
dialog box and choose the desired icon in the Choose Print Mode box of the Main tab. When you
print multiple copies of the same document, you need to specify the number of copies. You can
change the print order with Reverse and Collate, as needed. When Collate is disabled, the printer
prints the document and collates copies of the same page. Stamps are notations such as
CONFIDENTIAL or IMPORTANT, which are frequently rubberstamped on documents to alert
readers. Several default stamps are available for immediate use.Place stamp over text Click this
checkbox to print the stamp over the document data. If you leave the box unchecked, the document
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data are printed on top of the stamp. Two types of default backgrounds are available for immediate
use.If you leave this box unchecked, the background is printed on each page. Click the OK button to
close the Printer Properties dialog box and start the print job.
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Depending on the type of image data you print, you can use either Image Optimizer or Photo
Optimizer. Image Optimizer Enlarging an image often causes edges to look jagged. To solve this
problem, after enlarging an image in your application program, turn on the Image Optimizer before
printing. Click the OK button to return to the Main tab.Use the Photo Optimizer to compensate
unsatisfactory color balance and over or underexposure before printing. Open the Printer Properties
dialog box, then click the Main tab. Click the Advanced button. Disabled When the Whole Page
setting is disabled, the Photo Optimizer adjusts multiple photographic images appearing on the same
page separately. Enabled When the Whole Page setting is enabled, the Photo Optimizer adjusts
multiple graphic images appearing on the same page as a whole. Setting Simulate Illustration Use
this artistic effect to simplify complex image data so that a photograph appears to be an illustration.
The appearance of the image data in the preview area changes as if the photograph is converted to
an illustration at this time. If necessary, drag the slide bar to increase or decrease the contrast. Click
the OK button to return to the Main tab. Click the Special Effects tab. Check the Monochrome
Effects checkbox to enable the setting. The appearance of the image in the preview area changes to
a monochrome image. Select the desired monochrome effect from Sepia, Blue, Pink, Green or Select
Color. Click the OK button to close the Printer Properties dialog box and start the print job.The print
mode changes according to the setting of the slide bar. Please note that using a higher setting in the
direction of Fine requires more time for printing. Click the OK button to close the Printer Properties
dialog box. When you wish to print at the highest quality, set Halftoning to Diffusion. Set the
following items as needed. Color Balance Move the slide bars of the individual colors.

For example, when blues are too strong in the printouts, drag the slide bar for Cyan to the
left.Adjusting the brightness toward Light makes the overall image brighter, with stronger contrast
in the light areas and lower contrast in the dark areas. Click the OK button to return to the Main tab.
Click the OK button to close the Printer Properties dialog box. Open the Printer Properties dialog
box, then click the Advanced button in the Main tab. Click on the Color tab. Move the Intensity slide
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bar to the left lighter or right darker. Click the OK button to return to the Main tab. You can also
register your original stamp and background in the printer driver. Creating and deleting an original
print mode You can create an original print mode by changing the default properties of the Print
Mode settings as desired. Change the print settings in the Special Effects tab, if necessary.Click the
Save tab. You can save the desired print settings you made in steps 3, 4, and 5 here.You can use up
to eight characters. Please note that you cannot use a title that is preassigned in the printer driver
such as Draft or Standard. Note You cannot move the icon back to its original position by clicking
the Cancel button.Click the Save tab. Click the Open button. This displays the Open File dialog box.
Select the drive name and folder name in the Directory box. The icon of the original print mode is
deleted from the Saved Settings box in the Save tab.When you wish to create an original stamp,
select None in the Stamp box. Specify original settings related to the stamp position in the
Placement tab.Enter a name for the original stamp in the Title box of the Save settings tab. Click the
Save button.Select the stamp you wish to delete from the Title box. Click the Delete button.The
Background Settings Properties dialog box is displayed. Click the Select File button.Click the OK
button.Normally, the Canon BJ Printer Driver performs background printing.
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To verify the print process, click the B] Background Monitor icon minimized on the Windows
Taskbar. Drag the document you wish to change the priority of to the desired position. Please note
that you cannot change the priority of the document which is being printed. Select the drive and
directory. Click the OK button.If an error occurs for some reason, the B] Status Monitor displays the
cause of the error and a solution. In addition, the B] Status Monitor detects the remaining ink of the
BJ cartridge and displays a warning message when the ink is low. The following items are displayed.
Printer Name Shows the name of the printer you are using.For more details, refer to the online Help
for the B] Status Monitor. Then click the Guide tab and refer to the information on the solution.
When the remaining ink is running low, the BJ Status Monitor displays a low ink warning icon in the
Printer Status tab. Note Even after the ink runs out, the printer continues to print for a while.
However, it is recommended that you install a new BJ tank.To cancel the print job, open the B]
Status Monitor and then click the Cancel Printing button in the Printer Status tab. Switching the B]
Status Monitor When you are using multiple Bubble Jet printers and launching the B] Status Monitor
of each printer as well, select the port to which the printer you wish to display is connected from the
Port menu. You can view information such as the printer status, printer port to which the printer is
connected, and installed BJ cartridges. You can also launch the BJ Printer Monitor for a desired
printer. About the operating environment The following are the minimum requirements to run the BJ
Printer monitor. The icon to the left of the printer name shows the printer status. — Normal
condition. — A warning occurred for some reason. —. There are two ways to clean the print head
normal print head cleaning and deep print head cleaning.

If this does not correct the problem then execute deep print head cleaning. Note Cleaning the print
head consumes ink so clean the print head only when necessary. Only when the normal Note print
head cleaning does not correct the problem, perform deep print head cleaning. Open the Printer
Properties dialog box, then click the Maintenance tab. Click the print head deep cleaning icon in the
Print Head Cleaning box. Print the Nozzle Check Pattern when your printouts are streaked or the
color tones are not correct, or after performing print head cleaning. Click the OK button. Note You
can also start printing a Nozzle Check Pattern with the RESUME button on the printer.BC33e Color
Cartridge or BC34e Photo Color Cartridge 1 Nozzle check pattern 2 Print head alignment check
pattern for BJ cartridge If patterns 1 are broken or missing, print head cleaning is required.
Cleaning the Print Head If patterns 2 are not overlapped perfectly, print head alignment is required.
After cleaning the print head several times, if the Nozzle Check Pattern is not satisfactory, the print
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head may be worn out and the B] cartridge must be replaced. Open the Printer Properties dialog
box, then click the Maintenance tab. Click the print head alignment icon in the Print Head Alignment
and Test Prints box. For each line, enter the appropriate number where you see the lines perfectly
aligned. Make sure that the printer is on and lettersize paper is loaded; then click the OK button. For
each line enter the appropriate number where you see the lines perfectly aligned. Click the OK
button. This completes the print head alignment procedure. Note To turn off the printer after print
head alignment, always press the POWER button. Auto Power On Click the downarrow and select
either Enable or Disable. When this setting is enabled, the printer is turned on when data is sent to
the printer. The default setting is Disable.

Use this setting to prevent the backs of pages from becoming stained after they are printed and
ejected from the printer. Pause Scan Click this checkbox when you wish to increase the pause in the
print head operation while the print job is being executed. You can change the data transfer method
to ECP mode, as needed. The ECP mode makes it possible to conduct data transfer between the
computer and printer at a higher speed while keeping compatibility with the former interface type.
When you install a new version of the printer driver, delete the old version before installing the new
version. Uninstalling the B] Printer Driver with the Uninstaller When you use multiple Bubble Jet
printers and wish to delete all the printer drivers for the Bubble Jet printers at the same time, use
the Uninstaller feature. To use the printer with your computer, you must install the printer driver.
For instructions on installing the printer driver, refer to the Quick Start Guide. Using the Macintosh
Printer Driver. Set the paper size you use from within the application program before printing. Once
you have chosen the printer driver, it will remain selected. You will only need to choose it again if
you change to another driver. Close Click in the Close box to close the Chooser. A dialog box may
appear with this message You have changed your current printer. Please choose “Page Setup.” in all
the open applications. Simply click OK. In your application, open the Page Setup dialog box and
select the paper size that you want to use with your printer. The Page Setup dialog box closes.
Selecting the paper size for custom paper sizes When you use custom paper sizes, select any one of
Custom1 to Custom3. Select the command used for Page Setup in your application program.
Normally, click Page Setup from the File menu, and the Page Setup dialog box is displayed. The
Custom dialog box is displayed. Select inch or mm for the unit of measurement in Unit and enter the
desired height and width.

Print Mode Settings Using the Macintosh Printer Driver. Set the B] Cartridge and Media Type
settings to match your printer setup, then select the icon corresponding to the print mode which you
want to use to print your document. Setting the print mode and starting printing Select the
command used for Print in your application program. Click the dropdown box to display a popup
menu. Select the BJ cartridge combination you have installed and the media type you have loaded.
Note When a document created in color is to be printed out in monochrome, place a check mark in
the Print Grayscale checkbox. Select the icon that is closest to your document type and intended
results. The Current Settings show the name of the selected icon, along with the types of Print
Quality, Halftoning, and Color Correction. Print Mode Icons Prints documents made up primarily of
text at normal Text quality. Open the Print dialog box, and click the Options. button. The Options
dialog box is displayed. Select Preview as the output destination, and click the OK button. To close
the preview screen without printing, click the Cancel button. Using the Macintosh Printer Driver.
Open the Print dialog box, and click the Options. button. The Options dialog box is displayed. Select
PICT File as the output destination, and click the OK button. Using the Macintosh Printer Driver. To
display an explanation of these functions, use the balloon help. When you position the cursor over a
given item, a brief explanation of that item appears in a balloon. Displaying balloon help Select Show
Balloons from the Help menu. The Page Setup dialog box closes. To start printing, click the Print
button in the Print dialog box. Normally, select Print from the File menu to open the Print dialog
box.Open the Page Setup dialog box. Normally, select Page Setup in the File menu. Select Letter in



Paper Size. Click the Banner Printing checkbox to place a Click OK. Normally, select Print from the
File menu.

Select Plain Paper in Media Type. Click the Print button to close the Print dialog box and start the
print job. If you set multiple copies, the data cannot be printed on the banner paper properly. The 2
Up Print setting prints two pages on one sheet of paper and the 4 Up Print setting prints four pages
on one sheet of paper.Click on the dropdown box to select None, Fine line, or Broad line. The
Options dialog box closes. Print in reverse order Use this setting when you print a multiple page
document. The printer starts printing from the last page of the document.The Options dialog box
closes. Setting for Manual Printing Selecting the icon allows you to set your own printing
parameters, including the quality, halftoning, color balance, and density. The Color panel is
displayed. Adjusting the Image Data When you have completed the settings, click the OK button.
Then return to the Print dialog box. Note When the same print mode setting is to be used the next
time you print, select the. If there is a problem in the image data you wish to print, changes to the
print quality and halftoning settings may not be visible or effective. The further you move the slide
bar toward the right, the better the print quality will be, but the longer it will take to perform the
printing. The print mode display varies with the position of the slide bar. Select the Halftoning icon,
as necessary. Scatter Dots of different colors are arranged at random.Use the Photo Optimizer to
compensate for unsatisfactory color balance and over or underexposure before printing. Photo
Optimizer Place a check mark in the Photo Optimizer checkbox in the Detailed Settings dialog box.
You return to the Print dialog box. Adjusting the Image Data When the color reproduction of your
printouts is unsatisfactory, you can adjust the color balance and density as needed. The Color panel
is displayed. Set the following items as needed.

Color Correction BJ Standard Applies the optimum color correction for printing with a Bubble Jet
printer. Normally, you will select this setting. ColorSync Selected when color correction is
performed with ColorSync. None Selected when color correction is not to be applied. Generally, you
will use the Recommended by Canon setting. Only active when ColorSync is selected. Recommended
by Canon lists the color features that are suitable for the B] cartridge, paper size, print quality,
halftoning, etc. Gamma Correction Gamma Correction enables the adjustment of halftone contrast
between perfect white and perfect black. Then return to the Print dialog box. Registering and
Managing Print Settings You can name the settings in the Print dialog box such as B] Cartridge,
Media Type, Print Grayscale, and Print Mode when you perform registration. You return to the
Register Settings dialog box. Click the Close button. You return to the Print dialog box. Note You
cannot specify a name that is already being used for a set of print mode settings. Click the Close
button. Note When a registered Print Mode is to be set as the default so this print mode is always
selected when the Print dialog box is open, select its name in the Register Settings dialog box and
click the Defaults button. The selected print setting is removed from the list. Click the Close
button.Also, the order in which suspended documents are printed can be changed. About
background printing The print processing method that enables you to do other tasks simultaneously
while printing documents is called background printing. B] PrintMonitor Function The B]
PrintMonitor shows the document currently being printed and a list of the documents queued for
printing. Position the cursor over the name of the document whose position you want to change and
drag it to the desired position in the queue while holding down the mouse button.

To enable use of the printer from any computer connected to the network, the necessary printer
driver must be installed on each computer.On the print server, select the printer driver called S400.
Client machine Refers to a computer that is connected to the print server via an Ethernet network.
Executing Special Functions Using the Macintosh Printer Driver. Click the close box to close the
Chooser. Setting up client machines Select Chooser from the Apple Menu. Select the S400 Server
icon and select the print server in “Connected to”. Click the close box to close the Chooser. Starting



the BJ StatusMonitor Doubleclick the B] StatusMonitor icon in the BJ Extras folder. Closing the BJ
StatusMonitor window Select Quit from the File menu to close the B] StatusMonitor. A list of
documents that are currently being printed as well as those in the print queue is displayed. The
information related to the jobs in the print queue includes the document name, number of pages,
number of copies, and the time at which the print job was accepted. There are two ways to clean the
print head normal print head cleaning and deep print head cleaning. If this does not correct the
problem, then execute deep print head cleaning, which produces more intensive cleaning. After
cleaning the print head several times, if the Nozzle Check Pattern is not satisfactory, one of the print
heads may be worn out and the corresponding BJ cartridge must be replaced. Click the OK button.
The Nozzle Check Pattern is printed. Look at the check patterns and perform the correction
procedure. BC33e Color BJ Cartridge or BC34e Photo BJ Cartridge 1 Nozzle check pattern. Open the
Page Setup dialog box. Normally, select Page Setup from the File menu. Click the Utilities button.
The printer starts to print the head alignment pattern. During print head alignment, do not open the
front cover. Check all the patterns in lines of B1 and B2. For each line enter the appropriate number
where you see the lines perfectly aligned.
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